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Note

Capture Professional
Getting Started Guide

This Technical Note provides basic instructions for users who are new
to Capture Professional. This document provides an overview of the
steps you need to follow to scan documents. For more information,
refer to the online help files provided with the software.

The examples in this Technical Note were created using Capture Pro-
fessional release 4.1. If you are using a different release, your screens
may differ slightly. However, the basic principles presented are the
same.

Create a Settings Collection Using an Existing Document

Class

Before you can capture new documents into a batch with Capture
Professional, you must create settings collections to specify values for
the many parameters available to you. (Settings collections are
essentially configuration files that specify the settings used for
scanning, assembly, indexing, and virtually any function performed by
a Capture component.) Refer to the online help for information on
settings collections.
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Create a new settings collection, as follows:

1 Open the File menu and click the New command. Select Settings from
the secondary menu to start the Settings wizard.

FileMet Capture Settings Wizard |

T hiz wizard will guide you through the creation of Settings
Collections.

& Settingz Collection holds the operating parameters
neceszan to process one kind of document,

< Back I et » I Cancel

2 Click Next to advance to the next screen.
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3 When prompted for a repository, be sure to enter the name of the
Image Services, Content Engine or Content Services library, not the
Local Repository.

FileMet Capture Settings Wizard Ed

Select the Repository in which the Settings Caollection is to
be ztored:

< Back I MHext = I Cancel
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4  Enter a name for the settings collection in the name field.

FileNet Capture Settings Wizard

Do wous want b
" Edit an existing Settings Collection
¥ Define a new Settings Collection

— Edit existing Settingz Collection

[ ares j

— Define new Settingz Collection

Marne: Imv_settings

Bazed on exizting Settings Callection:

¢ Back I M et > I Cancel

August 2005 Capture Professional Getting Started Guide 4



Capture Professional Getting Started Guide
Create a Settings Collection Using an Existing Document Class

5  When prompted for a Doc Class, use one of the document classes
present on the library (Content Engine, Content Services or Image

Services repository). (Available document classes appear in the scroll
box.)

FileMet Capture Settings YWizard |

Pleaze zelect the DocClazs that iz to be azzociated with
my_zettingz

DocClazs:

ronclass
AWwWEClass
smoketest
stefolz

< Back I MHext = I Cancel
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6  The next screen displays a list of installed components. Use this
screen to select a component to configure within the settings
collection. Select a component from the list then click Configure to
specify settings for the component.

FileMet Capture Settings Wizard Ed

Components:

Assembly Configure
Blark Fage Detection d

Cornmit
DocProcessing
[mage Yerify
PrintF ax

Scan

Wiewer

Companent funckiomn:

Importz files from a directory into batches.

Select each Component and configure it for
my_zettings

¢ Back I Mext = I Cancel

For example, select the File Import component and click the Configure
button, to display the Capture File Import Property Page:
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FileMet Capture File Import Properties |

Filez |.-'1'-.ut-:|mati|:|n| Ennversiunl

File 5 pecification

Fath

Index File Extenzion

I— Erowsze... |

ak I Canzel | Apply | Help

When you have completed configuration, click OK to return to the
Settings Wizard.

7  Click Next to advance through the remaining dialogs and complete the
process.

The settings collection appears in the Settings folder, under the Config
folder on the library.

Use this settings collection as the Default Settings Collection for a new
template, as described in “Create a Template Based on the Settings
Collection” on page 8.
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Create a Template Based on the Settings Collection

A template provides a basis for a batch. A template defines the
settings collections and the capture path associated with a given
batch. Each batch has one and only one template. A template has one
or more settings collections, and at most one capture path associated
with it. Refer to the online help for more information on templates. Use
the New Template command to create a template for use on the library,
as follows:

1  Open the File menu and click the New command. Then select
Template from the secondary menu to start the Template wizard.
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2  When prompted to select the repository, be sure to select the name of
the library (Content Engine, Content Services, or Image Services
library), not the Local Repository.

FileMet Capture Template Wizard

Select the Repository in which the Template iz to be
shored:

< Back I MHext > I Cancel
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3  Select Define a new Template. Enter a name for the template in the
Name field under the Define new Template section. You can choose
an existing template to base your new template on by selecting a
template in the Based on existing Template menu.

FileMet Capture Template Wizard Ed |

Do you want to
£~ Edit an exizting Template
" Define a new Template

— Edit exizting Template

[ arme: j

— Define new Template

Marne: Imv_templatd

Bazed on exizting Template:

! [

¢ Back I Mext = I Cancel
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4 When prompted to select a settings collection, select the one you
created in “Create a Settings Collection Using an Existing Document
Class” on page 1. (You can select additional settings collections, if they
are available.) Click Next. For this example, you do not have to
associate a capture path with the template.

FileMet Capture Template Wizard

Template Mame:  myv_template

Fleaze select one or maore Settings Collections ;

Default Settings Collection:
rv_settings j

¢ Back I Mexst = I Cancel |

5  Click Finish to exit the Template wizard. The template is stored in the
Template folder within the Config folder on the repository.
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Create a New Batch Based on the Template

Once you have created a template, you can use it as the basis for the
batch. When you create a batch, the batch inherits all of the
configuration settings (the settings collection) that are defined for the
template. Refer to the online help for more information on how to
change settings for a batch or a template.

Use the New Batch command to create a new batch as follows:

Select a folder from the Tree view. (Do not select a folder within the
Config node unless you are going to delete the batch when you are
done with this example exercise.)

Open the Edit menu and click the New Batch command to create a
new batch. This new batch will be based on a document class from
your repository. Specify the new batch using the New Batch dialog box
as follows:

a Enter a name for the batch, or leave the batch name field blank to
automatically name the batch. (Contact your Image Services, Con-
tent Engine or Content Services system administrator for batch
naming restrictions on your system.)

b Specify the template to use as a basis for the batch. Select the
template that you created in “Create a Template Based on the Set-
tings Collection” on page 8.

c Select the settings collection you created as the Default Settings
Collection in “Create a Settings Collection Using an Existing Docu-
ment Class” on page 1.
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Create a New Batch Based on the Template

Mew Batch

Batch name:

=]
k. I
IBat-:h1 j Cancel |

Create bazed upon the following Template:
Help

emplate

Fram the Template, uze the following Setting:

I Setting j

Document Class: indesless

Scanning target verfication:

Expected number of, documemnts; ||:|
Expected number of pages: ||:|

3  Click OK to create the batch. Continue to “Load the Documents into
the Scanner” on page 14.
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Load the Documents into the Scanner

In this section, you will make configuration changes at the batch level.
These configuration settings are stored with the batch, not with the
settings collection. They are only used for the specific batch, and are
not reflected in the settings collection or template.

Place the documents you want to scan into the scanner's feeder (or
place a document on the glass for a flatbed scanner).

From the Tree view, highlight the batch you created in the previous
procedure.

From the Tools menu, click the Configure command. Then select the
Scan command to display the Scanner Controls dialog box.
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FileMet Capture Scan Properties n

General | Stamperl Event Nu:utifiu:ati-:unl .-’-'-.dvanu:edl

Scanner

@ Mame: 4 Fuiisu 3093de Propeties... |

Type:  Kaofax ImageCantralz %365 60

| Select Scanner... I

Estended Options
%‘\ Configure additional scanner features:

il
IBar Code Properties j Configure. . |

(] I Cancel Apply Help

3 In the Scanner Controls dialog box, click the General tab.

4 If a scanner driver is already configured, it will appear in the Scanner
Type field. If the scanner driver is not configured, click Select Scanner,
and then select your scanner driver from the displayed list.
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Select Scanner

|
— Scanner Details k. |
Mame: [Mo scanner zelected]

Type: Mot Found

Help |
.@.ﬂ.gfa Duazcan T1200 "
¥ aipple Color One 1200430
¥ sipple Color One GO0/27

@ Bell & Howell 1000FE
@ Bell & Howell 1500FE
@ Bell & Howell 2135 with RSC
@ Bell & Howell 2137 with RSC
@ Bell & Howell 2138 with RSC

P -
i | :

5 Click OK.

6  From the Tools menu, click the Start command. Then select the Scan
command. You should hear the scanner initialize, and then scan the
document(s). A scanner without an auto feeder will prompt you to
insert additional pages.

7  As each page is scanned, the acquired image displays as a page icon
in the List view of the Capture Professional window. Double-click a
page icon to display the page in the Workspace view.
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% FileNet Capture

File Edit Yiew - Tools Window Help

[tme||srfEm K rn[ra][o00onITaNBIRITRIEG S ||[HE |
[onpprrrcrawe
ﬁj i WorkspaceYiew M=l E3
|dscpf3:!MRSTest-’MERS 2/PressRel1.tif
g ala] t[e[+fa a(Al o« Comal o || 8l s
E-IE BEH!H
- —] Document 1 ﬂ / "
= / FileNet Capture De
Contents of MERS 2 ‘FiENET
#] 1- PressRefl i
] 2- PressRelz fif
4 3- PressRela fif
# 4- PressRel i

AnECM Functle

57341 [adHoc | [MUM

For Help, press F1

You have now captured a batch of documents that you can assemble
and process.
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Using the Help System

There are three ways to search for information, a specific topic or a
word in the online help:

» The Contents tab is organized much like the Table of Contents in a
printed book. Related topics and procedures are grouped together.

» The Index tab presents a list of specific words and topics, listed al-
phabetically.

» The Search tab locates all occurrences of a specific word or group
of words.

The following steps present a brief sample of each method.

Note To display help for a specific dialog box, click Help or press the F1 key.

Using the Contents Tab

1  Select the Help menu and choose Help Topics. (Refer to the previous
Capture illustration.)

2 Inthe Help Topics window, click the Contents tab to display the Table
of Contents.
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E2 FileNET Capture Online Help =] E3
- &
Hide Eack Frint  Oplionz
= =
Contents | |nd 5 h Prewi M et E E E E @_
| Ot I 2230 I [EE = A Workspa.. Hiding, Repositio... Place b onitarir #
H - .\-"iews and Fan Wigw or Show... andResi.. anlndivi.. Selected
+ - wihat's New ;I
"@ System Tour Welcome to Capture Professional Online Help
@ Common Capture Procedures
=@ Automating Capture Welcome: Welcome Documentation

This Help system describes the operations performed using Capture
Professional. You can find information in the fallowing ways:

» Selectthe Contents tab to select a topic from the tahle of
contents. The table of contents displays all tapics in outline
farm.

s Selectthe Index tab to list topics aszociated with a
kenvword. You can enter a keyword or select one from a
supplied list.

s Selectthe Search tab to listtopics containing any word ar
phrase. The first search will prompt you to minimize ar
maximize the size of the database.

If any ofthese features is notwaorking correctly, this Help file has heen
corrupted and must be reinstalled.

3 Expand the book titled “Common Capture Procedures,” and then
expand the book titled “Document Capture.”

4 Expand the book titled “Importing Files and Images” to display a list of
topics related to importing files.
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E? FileNET Capture Online Help =] E3
=
Hide Eack Print  Options
= =
Contents | |ndex | Search Previouz  Mest kil il 7 kil il
| ~ I ~ I | Workspa... Hiding Repositio... Place M onitorir
@ Matices and General Infomation W Vizws and Pan + Wiew or Show... andResi.. anlndivi.. Selected

@ what's New

@ System Tour

=-A{ Comman Capture Procedures

@ Baziz Scanning Procedures

% Scanner Canfiguration

-1 Document Capture

- Dverview

- Offine Scanning

L:_||I:_f| Importing Fil nd Imag
-~ | 2] File Irnpart Overyiew

E Importing Files

E Configuring the File Imp

- 2] Selecting a Destination

E Runring the File Import

E File Import &utamation F

E Importing Multipage TIF

E Supported File Types
o [2] Index Values

[]--@ E=porting Images

E]--@ Troubleshooting

- i@ Document Assembly

7@ DocProcessing

- Document Entry

]—-@ Optical Character Recognition [

- 8@ Using Poling Functions
- Enabling Blarnk Page Detection

(00 O e O O e O O e O e B w

4] |

Fs

:I--@ Prirtirg and Faxing -

]--g Enabling Formz Hecognition_lll
>

=

Welcome to Capture Professional Online Help

Welcome: Welcarme Docurmentation

This Help systermn describes the operations performed using Capture
Professional. You can find information in the following ways:

s Selectthe Comtents tab to select a topic from the tahle of

contents. The tahle of contents displays all tapics in autline
farm.

e Selectthe Index tah to listtopics associated with a

keyword. Wou can enter a keyword or select ane from a
supplied list.

» Selectthe Search tab to list topics containing any word or
phrase. The first search will prompt you to minimize or
maximize the size of the database.

If any of these features is notwarking correctly, this Help file has heen
corrupted and must be reinstalled.

[

5  Double-click on the topic “Importing Files” to display the help topic.
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g2 FileNET Capture Online Help [_ (O]

CE

Hide Back Print  Options

= =
LContents | Index | Search | Prewvious  Meut — il il [B—

A Offline Offline File: Configurir ™
-8 Notices and General Information « W Oocument Cap Capture...  Scannin..  ImportO... File Impa
@ wihat's New -
@ System Tou Importing Files ~
=-{) Commorn Capture Procedures P 9
7@ Basic Scanning Procedures File Import: COverview: Procedures Reference

E% gzz:r:;r::tocn:g:ﬂ;mn You use the File Import component to impaort files into a batch for

. . P subseguent processing. The imported files may reside an another
@ Overview server, in a local folder, or amywhere accessible to vour workstation.
@ Offine Scanning Once files are imported into a batch in this manner, they can be

[.'QI Importing Files and Images processed in the same way as scanned images.
- [7] File Import Overview
E Imparting Files
] Configuring the File Immp Importing Files
- [?] Selecting a Destination
E Running the File Import 1.  configure the File Import component to specify the fileds) to he
E File [mpart Automatian F impaorted, and other parameters.
2] Imparting Multipage TIF 2. EBelectthe destination far the imported files. The destination
- (2] Supparted File Types must be a batch, docurnent or page.
- ] Index W alues

B % Expurting Images 3. Etartthe File Import component.

- Troubleshooting

-8 Document Assembly Imported files, in one or more suppoted formats, are typically the
[]--@ DocProcessing output of another systemn's application. For many files, especially if
[]_@ Dacurnent Entry they are exported fram another system, the index values are exported
- Optical Character Rrecognition [ as well. When you impart files, wou may also import index values.
- Printing and Faxing | Youcan also use the File Import component to automatically maonitar
- @ Using Polling Functions a selected folder on a local or network drive for files matching certain
@ Enabling Blank Page Detection criteria, then automatically import these files. For more information, -
-4 Enabling Forms Recognition see File Import Autornation Features.
¢ | ok - . | _'lll You can automate the process ofimporing files further by including
the File Impart component in a capture path. To do this, refer to the ;|
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Using the Index Tab

1 Click the Index tab and enter “imp” to jump to the import topics.

E? FileNET Capture Online Help =] E3

5 oe &

Hide Back Frint  Options

= =
Contents  Index | Search Previ Mext —% i i iy
o | search] s TS el Offine Offine File Configurir *
Type in the keyword ba find: B Uocument Cap - Capture ... Scannin..  |mport 0. File Impao
Iimp -
— Importing Files
automation features File Import: Cverview Procedures Reference
Importing Files
IMS

You use the File Impart component to impart files into a batch far

|Mdseig’§§'sm subsequent processing. The imported files may reside on anathear
defined server, in a local folder, ar anywhere accessible to vour warkstation.
irdex Once files are imported into a hatch in this manner, they can be
a batch of documents pracessed inthe same way as scanned images.

a zingle batch

agzign field properties dialog
checking for previous indexing Importing Files
configure autoindex properties
configure display order far index names

canfigure field properties for an indes field__g 1. Configqure the File Import component to specify the file{s) to be
configure for autoindesing from external in imported, and other parameters.

figure for batch total
confiure general field properties for an in 2 Belsctthe destination for the imported filas. The destination

configure index fields for a single batch rnust be a batch, document or page.

configure index kevboard shortcuts .
configure indexing fields for zettings 3. Startthe File Import component.

configure the Index Cantral Properties Gel

create sample batch Imported files, in one or more supported formats, are typically the
general procedures output of anather system's application. For many files, especially if

overview of indes et up and index entry
reindex
rezume mid-batch

they are exported from another system, the indexvalues are exported
as well. When you import files, yvou may also import index values.

start configure “ou can also use the File Impart companent to automatically manitar
stopping mid-batch a selected folder on a local or network drive far files matching certain
o check for previous indexing criteria, then autamatically impartthese files. For mare infarmatian, —
index: control properties = see File Import Autormation Features.
Dizplay | You can automate the process of importing files further by including
the File Import component in a capture path. To do thig, refer o the Ll

2 Click Display to display the first selected topic, which is the same as
the topic you displayed earlier.
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Using the Search Tab

1 Click the Search tab.

2  Inthe search field type the word “import” then click the List Topics
button. Select the topic “Importing Files” from the list.

E? FileMET Capture Online Help =] E3

< ET-

Hide Back Print  Ophions

= =
Contents | Ind Search Frevi hext —7 il il =]
Contenis | Index | EveE S al Offine Qffine File Configurit ™
Tuvpe in the word(z] to search far: .D-:-c:urnent Cap = Capture ... Scannin..  Impaork 0. File Irmpo
|im|:-c-rt LI ﬂ -
Lizt Topics | Dizplay | Impor‘tlng Files

Select topic: Found: 74 File Import: Overview Procedures Beference

Titl= | Location | Rar~ You use the File Impart component to impart files inta a batch far

Owerview of dutoind... FileMET Ca... 1 subsegquent processing. The imported files may reside on another

F!unr)ing_ File !mpolt FiIeNET Ca.. 2 server, in a local folder, or ampwhere accessible to yvour warkstation.
Canfiguring File Impa... FileMET Ca.. 3 Once files are imparted into a batch in this manner, they can be

File Impoit Dverdiew  FileMET Ca. . 4 processed in the same way as scanned images.

Imparting Files FileMET Ca... °F

Configuring the File ... FileMET Ca... B |

File Import Automatio... FileMET Ca.. 7 Importing Files

Filz Import Properties... FileMET Ca... 8

File | tF ties... FileMET Ca.. 8

|rLEDT:i$1;'ML:E|;Z;:S_“ F:IENET ,::_” 10 1. configure the File Import component to specify the fileds) to he
Supported File Types  FileMET Ca.. 11 imported, and other parameters.

Emf'tgu””dg tche F"E--- E!:E:g Ea--- 1% 2. Belectthe destination for the impored files. The destination

reale an QAFgur... e a...

Sort Order after File ... FileNET Ca... 14 musthe a batch, docurment or page.

Pozsible Cauzes of ... FileMET Ca.. 15 3. Stard the File Import component.

Import Button FileMET Ca... 1B

E"e Impog Properties. . E!:E:g Ea"' 1; Imported files, in one or more supported formats, are typically the

Da':'t”r.e D'F"I':'ane”és F!IENET Ea“' 15 output of another systern's application. For rany files, especially if

WEMGEW Ol INdeR 2. TIe - they are exported frorm another systern, the index values are exported

Selecting a Destinati... FileMET Ca... 20 ) - -

Automation Overview  FieMET Ca. 71 as well When vau impart files, you may also import indexvalues.

Ewvent Activatar Owe... FileNET Ca... 27 » You can also use the File Import component to automatically monitor

< - B a selected folder on & local or network drive for files matching certain

[~ Search previous results
v Match similar words
[~ Search titles only

criteria, then automatically import these files. For more information,
zee File mport Automation Festures.

You can automate the process of impaorting files further by including
the File Import component in a capture path. To do this, refer to the
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